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3D Path Tracing: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
File Overlay 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Taking a massive leap from the 3D output of past versions, this release boosts SoftPlan’s 3D rendering power to 
unprecedented levels. By increasing the maximum path tracing from 1,000 to 20,000 passes, SoftPlan can now 
create drastically improved 3D images. Additionally, this version handles transparent surfaces and semi-opaque 
textures more accurately, reducing artifacts in the image to achieve absolute clarity and detail. Combining these 
changes with the greatly advanced rendering of backgrounds allows SoftPlan 2024 to produce significantly more 
realistic 3D images and animations. 
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Overlay: 
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One of the biggest changes in this release is SoftPlan’s new Overlay functionality. The Overlay command makes it 
easy to add overlays of other floors to the current drawing and specify the items that are visible on each floor. This tool 
streamlines the drawing process by providing a visual guide of the walls, floor system components, and other items 
that must be considered when designing the floors of a house. With the overlays in place, you then have the option to 
create an overlay viewport that can be cropped to only display the items from other floors you want to be visible on the 
drawing. 

Pool: 

 
Adding to SoftPlan’s array of site creation tools, this release 
introduces a set of special commands that make it much easier 
to draw and customize swimming pools. Using simple drawing 
techniques, a pool can be quickly added that will automatically 
cut the ground and other site polygons. Once drawn, the pool 
can then be edited to specify its depth, water line, appearance, 
coping, and more. Next, pool transitions, benches, and steps 
can be added to provide the pool with a more realistic 
appearance in 3D. 

A Single Stair Displays on Multiple Floors:  
 
A big overhaul to SoftPlan’s stair behavior introduces the ability to display a single stair on multiple floor plans. This 
addition eliminates the need to add the same stair to two different drawings since a stair can now be made visible on 
the floor above or below with a click of the mouse. This also means that the stair does not need to be modified to extract 
correctly in 3D views, elevations, and cross sections. Once the stair is visible on the selected floor, you can then Edit it 
and use a clipping tool to ensure the stair and its railings appear on that floor exactly as the design requires. 
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Structural Grid:  
 
A new command in Framing mode allows the user to create a structural grid over the drawing by adding grid 
lines that SoftPlan automatically numbers and letters. Once added, these grid lines appear as structural grid 
line details on annotated elevations, sections and as extracted planes in the 3D model. 

Quick Mode Change:  
 
Adding to SoftPlan’s many organization tools, 
this release includes a way to prioritize the 
drawing modes you most commonly use. By 
allowing you to assign the modes to a custom 
quick-selection menu on the SoftPlan Ribbon 
Bar, this time-saving feature makes it easier to 
seamlessly switch between drawing modes 
while working. 

Satellite Image:  
 
In addition to Google Maps site data, SoftPlan+ 
subscribers now have the ability to import Google Maps 
satellite images. With a few clicks of the mouse, SoftPlan 
automatically imports, scales, and rotates the satellite 
image to fit the size of the workspace. Once imported, the 
satellite image is added to its own Layer and can even be 
included on a Plan Set page for printing. 

Cursor Snap on Extension Lines:  

 
With the Cursor Snap function enabled, this version 
displays visible snap points on extension lines when 
drawing dimensions. Using the Dimension Spacing value 
set in the Dimension Options as a guide, SoftPlan 
projects evenly spaced snap points on the extension line 
which allows for quick and accurate placement of 
dimensions. 
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Rigid Frame:  
 
New to SoftPlan 2024, the Rigid Frame command expands 
SoftPlan’s extensive roof framing capabilities by providing a way 
to add rigid framing to industrial and agricultural-style buildings. 
Once drawn, the dimensions and other properties of the frame’s 
rafters and columns can be quickly modified to accommodate 
the needs of the design. 

Symbols/Post Stretch: 

 

SoftPlan 2024 provides a much greater level of control 
while configuring symbols by adding a new option for 
specifying an offset distance to stretch items such as 
posts, spindles, fence board, and other symbols. By 
setting an offset cut plane on the post or symbol, you 
can decide how the item will scale when modifying its 
dimensions so that it appears correctly in 3D. 

Exterior Bi-Folds Exterior Openings: 

  
This release expands SoftPlan’s vast collection 
of customizable opening types by adding exterior 
bifold doors. Using the Panel Count option, new 
exterior doors can be configured to have a 
specified number of folding panels. Likewise, the 
panels on existing folding doors can be modified 
to achieve the perfect look for the design. 

Share Project with Company:  

 
SoftPlan 2024 expands the sharing capabilities of SoftPlan+ by adding a new option for sharing a project with all 
key numbers within a company. With a single click of the mouse, a project can be shared company-wide without 
the need to specify each key number that is to receive the project. 
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3D 

 3D texture follows the direction of a Brace  

 Auto Match to Texture command is activated via a 
push button allowing Repeat Edit of the command  

 Copy in 3D has the same options as the Copy 
command in 2D: Number of Copies, Distance, Equally 
Space Between, and Multiple Placement  

 Door opening animation ability added to 3D 
walkthroughs  

 Draw Select of an opening replicates the Trim and 
Grille settings of the source opening on the new 
opening  

 Each 3D View and 3D Framing View file can have 
different Visible Floor settings  

 Edit of the Display option for a material Repeat Edits  

 Find in Material Tree command added to Edit Surface 
menu – opens the current selection in the Material 
Texture Edit menu  

 Path Traced DirectX 12 renders greatly improved  

 Room Names and Room Sizes automatically added to 
Annotated Presentation Views  

 Sherwin-Williams colour swatches are the newest 
versions  

 Transparencies improved when using DirectX 12  

 Walking Height options added to control both 3D and 
VR (Virtual Reality) camera height when walking 
around  

 
Area  

 Auto Trace Area locates the edges of a Deck polygon  

 Colour on Schedule matches colour on Area  

 Drawing column added to Area Schedule  

 Paint option added to Area polygons  

 Total is now the sum of the rounded areas in the list  

 When a Deck is drawn, a corresponding Area is 
automatically added to Area mode  

 
Building Options  

 All Building Options that an item is assigned to list on 
the right-click of the item  

 Building Options that are currently enabled for a 
project display as bold in the Assign Building Options 
menu  

 Custom Building Option Visibilities added to embedded 
Annotated views on Plan Set pages  

 Footings will form correctly when two structural slabs 
on separate Building Options overlap and one of the 
Building Options containing one of the slabs is turned 
off  

 Items on a Locked Building Option can no longer be 
modified via Repeat Edit  

 Lock Invisible Building Options option added  
 
 
 
 
 

 
Beams  

 Adjust Height to Fit to Top of Beam option added to 
Posts  

 Beam Labels list and round differently depending on 
the material composition of the beam. Dimensional 
lumber is listed nominally while engineered lumber and 
steel are listed with actual dimensions  

 Beam Length display includes the Projection distance  

 Beams on metric drawings use the Width x Depth / 
Depth x Width option when labelling beams  

 Board Thickness options added to Beam Detail  

 Default Value type control added to Beam Projection 
field  

 Inner and outer edges of the Beam are located by 
Snap  

 Face Mount option added to Beam Definition. Beams 
defined this way draw with no overhang  

 LVL Beam, Glulam Beam, and I Beam thicknesses and 
depths have been updated to standard sizes  

 Pressure Treated Beams added to defaults.  

 Search command added to the Draw > Beam menu  

 Section Thickness option added to Beam Definition  
 
Cabinets  

 Add Cabinet Fill command added to the right-click of a 
cabinet run  

 Adjust available for Countertops in 2D and 3D  

 Area Pricing option added allowing Doors and Drawers 
to be priced by the square metre  

 Back Panel options added to control the appearance of 
the back of an island  

 Cabinet ID column added to Cabinet Schedules  

 Cabinet Face column entries drawn rendered rather 
than vectored (with lines)  

 Customize Option added to the Position on Cabinet 
Legs  

 End Panels on Desk Cabinets extend to the floor by 
default  

 Face Pricing Method option added to Cabinet 
Schedules. Pricing can be set to Part (by the door) or 
Area (by the size of the door)  

 Flat Panel faced cabinet hardware placement 
improved  

 If the Replace Cabinet command is used on the last 
cabinet in a Cabinet Run (when placing a dishwasher, 
for example), an End Panel is automatically placed  

 Preformed Countertop can default on  

 Single Panel Shaker Cabinet Face Style added  

 Spacing and Offset options added to Cabinet Shelves  

 Vertical Dividers option added to Cabinet Shelves  
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Decks  

 Add Parting Board To Deck Edge command added to 
right-click of Deck edge  

 Auto Trace Area locates the edges of a Deck polygon  

 Autorail added to right-click of a Deck Landing  

 Deck Joist Type option added to Ring Joist  

 Deck Ledger component added  

 Deck Schedule added to Visible Items > Notes options  

 Depth of Deck Ring Joist is independent of Deck Joist  

 Patio added to Draw Deck menu  

 Show Slope option added to Ramp  

 When a Deck is drawn, a corresponding Area is 
automatically added to Area mode  

 
Details  

 Board Thickness options added to Beam Detail  
 
Electrical  

 Auto placement of outlets improved  

 ESC key cancels drawing of an Arc Connection  

 WP outlets added  
 
Elevations & Sections  

 Add Marker To Other Side command added to Edit of 
an existing Marker Line  

 Block Move enabled for Opening ID, Product Code, 
and Opening Size notes on Annotated Elevations and 
Sections  

 Default Colour Configuration option added to Elevation 
Marker Lines  

 Cross Sections saved as a line drawings include 
insulation in floor joists  

 Improvements made to the placement of Marker Line 
and Roof Pitch labels on complicated projects  

 Improvements made to placement of Opening Sizes 
and Opening Hinges on Annotated Elevations  

 Marker Line labels on Elevations and Sections can be 
formatted as Multi-Line Text  

 Marker Lines automatically added to the top of a roof 
parapet  

 Marker Line label text on Elevations and Sections is 
masked  

 Orthographic Extension Lines can be pulled from 
angled wall corners  

 Pen override option added to Section Line Marker  

 Repeat Edit of Shutters enabled on Elevations and 
Sections  

 
Erase  

 Braces added to Type Erase  

 Vegetation added to Type Erase  
 
 
 
 
 
 
 
 

Extensions  

 Single and Item Extensions can be pulled from 
Dynamic Cross Openings  

 Align to Edge & Make Parallel allow selection via an 
item's Extension  

 Extensions are automatically updated when the 
Projection on a Log Wall is changed  

 Reference Points are extensionable items  

 Snap points automatically displayed on Extensions at 
the location where the Auto Dimension command 
would place them  

 
File  

 Create Overlay Viewport command added  

 Export SketchUp 2021 files added — SoftPlan+ only  

 Import of AutoCAD DWG files with polygon shaped 
clipping planes added  

 Import of a DWG/DXF into a SoftPlan project: 
AutoCAD paper spaces automatically create SoftPlan 
Plan Set pages by default  

 Import DWG file includes No Print setting  

 Import of DWG files containing elliptical arcs improved  

 Imported images and PDF images can be set to Auto 
Update — when the external file is changed, the 
change automatically reflects in the SoftPlan Drawing  

 Import SketchUp 2021 files added  

 Include Overlays option added to DWG, DXF and PDF 
Export  

 New Projects Upload to SoftPlan+ Cloud option added 
to System Options > SoftPlan+ Options  

 File & Overlay completely revamped — additions 
include multiple overlays and granular visibility options 
by item and mode  

 Projection Snap points are generated from the lines of 
an overlaid file  

 Round Trip of files from SoftPlan to DWG to SoftPlan 
improved  

 SoftPlan's No Print setting is included in DWG exports 
resulting in the creation of a no print layer in the 
AutoCAD DWG file  

 SoftPlan Projects are located under the Windows 
Documents folder by default (This can be changed in 
System Options)  

 Exclusivity option added for SoftPlan+ projects — 
exclusive projects cannot by copied by anyone they 
are shared with, and the ability to export or print the 
project is up to the discretion of the project owner  
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Floor System  

 Break Joists at Bearing Below option added  

 Draw Grille changed from “expanding box style” draw 
action to a "symbol style" draw action — select an 
anchor point & orientation and a 300 x 100mm Grille is 
placed  

 Fillet added to Floating Toolbar in Floor System mode  

 Footings will form correctly when two structural slabs 
on separate Building Options overlap and one of the 
Building Options containing one of the slabs is turned 
off  

 Lines on an overlaid drawing can be snapped to when 
drawing and adjusting items in Floor System Mode  

 
Model  

 Auto Basement command utilizes the new Show Stair 
on Floor Above command  

 Auto Floor Above command added  

 Improvements made to Auto Basement when multiple 
Garage Doors are present  

 
Move  

 Align to Edge & Make Parallel allow selection via an 
item's Extension  

 Align to Edge can use lines from walls on overlaid 
drawings as the target location  

 Centre In Room works when the room's walls are 
different thicknesses  

 Copy in 3D has the same options as the Copy 
command in 2D: Number of Copies, Distance, Equally 
Space Between, and Multiple Placement  

 If two dimensions are identically located in two different 
modes and one is moved, the other no longer moves  

 Items can be moved by selecting their Extension  

 Items will remain on grid when using Block Move while 
zoomed out on a drawing  

 Modify added to the right-click of an item  

 Only building objects are considered when reversing a 
drawing. Items such as notes & dimensions are 
ignored so that walls on a reversed floor plan are in the 
same location  

 Polygon edges with deflections can be adjusted  

 Selection Sets can be relocated using the Align to 
Edge command  

 
Nest  

 Add to Region command added to Repeat Edit on an 
item  

 Auto Crop to Nested Region option added when 
placing a Drawing that contains a Nested Region into a 
Plan Set  

 Open Source Drawing added to right-click  

 Remove From Region command added to Repeat Edit 
on an item  

 
 
 
 
 
 

Information Stamps  

 @PG_GROUP Information Stamp added  

 @Property_Area Information Stamp reads from the 
drawing stack rather than just the host drawing  

 
Interiors  

 Paint option added to Interior polygons  

 Placement of Interiors on the butt-ends of Walls 
improved  

 Wall Grille command added  
 
Interior Elevations  

 Pen override option added to Interior Elevation Marker  

 Using the mouse wheel to Zoom is smoother  
 
Layers  

 Default Layer option added to Walls and Beam 
Definition  

 Items on Locked Layers can no longer be modified via 
Repeat Edit  

 Layer option added to Geo-Location Point  

 New Group, Remove Layer, Add New Layer, and 
Reset to System options added to the right-click on the 
active layer window  

 When pasting an entity into a drawing, if the item is on 
a Layer that is not visible on the drawing, a prompt 
appears asking to turn on the visibility of that Layer  

 
Dimensions  

 Bold option added to Dimension number  

 Dimensions are only added to Banding on a Wall if the 
Shape Dimension option is selected  

 Dimensions are not placed on Revision Clouds  

 Identical dimensions cannot be placed directly on top 
of each other  

 Mask All option added to Dimension Options.  

 Snap points automatically displayed on Extensions at 
the location where the Auto Dimension command 
would place them  

 
Ceilings  

 Ceiling Ring Joists intersect with a butt joint rather than 
a mitre  

 Clip to Ceiling option added to Roof Edge Edit  

 Draw Grille changed from “expanding box style” draw 
action to a “symbol style” draw action — select an 
anchor point & orientation and a 300 x 100mm Grille is 
placed  

 Ring Joist Type option added to Ceiling  
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Finishing Options  

 Brace finishing option added  

 Corner Board finishing option added  

 Gutter finishing option added  

 Fascia finishing option added  

 Frieze Board finishing option added  

 Shadow Board finishing option added  

 Splash Board finishing option added  

 Transition Board finishing option added  
 
Miscellaneous  

 Add/Remove Selection command added to the Tools 
menu  

 Assign Drawing Modes on Menu option added to 
System Options  

 Check for Updates command added to Help ribbon bar  

 Draw Select command can select on one drawing and 
draw on a different drawing  

 Distance field is automatically highlighted when 
copying an item  

 Elliptical Arc command added  

 Line Types: 3 new dashed line types added  

 

                     
 

 On Drawing vs. All option added to the Visible Items 
menu  

 Projection Snap points are generated from a 
Reference Point  

 System Options: Folder Locations menu options 
simplified  

 Toggle Attach added to Keyboard Shortcut 
Configuration  

 Toggle Group added to Keyboard Shortcut 
Configuration  

 Toggle Link Floors added to Keyboard Shortcut 
Configuration  

 Toggle Select Point added to Keyboard Shortcut 
Configuration  

 Toggle Visible Only added to Keyboard Shortcut 
Configuration  

 Toggle Shape Dimension added to Keyboard Shortcut 
Configuration  

 Toggle Symbol Dimension added to Keyboard Shortcut 
Configuration  

 Visible in All Modes option added to the Common tab 
for Shapes, Symbols, Beams, Extensions, and 
Dimensions  

 
 

Notes  

 Annotated Elevations and Sections can be included as 
source drawings for Revision Note Schedules  

 Area Schedule Drawing column added  

 Bold, Italics, and Underline ability added to Multi-
Format Notes  

 Cabinet ID column added to Cabinet Schedules  

 Trailing zeros are suppressed on Cabinet Schedules  

 Char Map command added to Note menu — allows for 
direct selection of specialty characters within a Font 
definition  

 Centre In Room works when the room's walls are 
different thicknesses  

 Current Drawing vs Drawings in Model option added to 
Room Finish Schedule  

 Deck Schedule added to Visible Items > Notes options  

 Double pointer command added — places a pointer off 
each end of a Note 

 Font SPHandSmallCaps added  
 

           
 

 Hardware column added to Opening Schedules  

 If Auto Scale Notes is selected on a Plan Set, the first 
segment of a Segmented Pointer remains horizontal  

 Opening Schedules: Glazing Area for specialty 
windows that contain a deflection is properly calculated  

 Room Names and Room Sizes automatically added to 
Annotated Presentation Views  

 
 

       
 
 

 Save as Default option added to Edit Schedule menu  

 SPHAND font contains the ® (registered trademark) 
character  

 Renumber Keynote IDs command removes keynotes 
from drawings that have been removed from the 
project folder  
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Openings  

 A single Transom is added over multiple single mulled 
openings  

 
 

 

               
 

 Arch openings of different sizes are assigned different 
Opening IDs  

 Block Move can be used to relocate an arrangement of 
Openings along a Wall  

 Centre Opening improved for Openings in Walls 
defined with zero width materials  

 Change Size command added to opening’s right-click 
— replaces the current opening with the next wider, 
narrower, shorter, or taller Opening from the current 
Library  

 Combined Unit With Doors type added to Items to 
Include for Opening Schedules  

 Combined Unit Without Doors type added to Items to 
Include for Opening Schedules  

 Custom Header Plate option added — allows a Plate 
to be placed directly Above or Below the Header  

 Multiple Horizontal Sections option added to a single 
trapezoid Opening  

 

                      
 

 Grille Style option added to round windows  

 Door opening animation ability added to VR sessions  

 Door opening animation ability added to 3D 
walkthroughs  

 Draw Cross Opening Solid option added to Material 
Options > Opening Options  

 In 3D, Draw Select of an Opening replicates the Trim 
and Grille settings of the source opening on the new 
opening  

 Grille placement on Garage Door Elevations improved 
when the size of the glazing section varies widely  

 Hardware column added to Opening Schedules  

 Improvements made to placement of Opening Sizes 
and Opening Hinges on Annotated Elevations  

 Mask option added to Dimension/Extension Options > 
Opening Options  

 Opening Schedules: Glazing Area for specialty 
windows that contain a deflection is properly calculated  

 Openings can be selected from one floor and drawn on 
another  

 

                     


 Pivot Swing option added to Door Components — 
allows for the creation of Pivot Doors  

 Sorted column settings are applied as new openings 
are added to schedules  

 

                  
 
 

 Spacing Option added when placing a Transom above 
an Opening  

 Two section Pocket Doors centre properly  
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Paint  

 Paint (Hatch or Image) can be added to Area, Interior, 
Room Modes replacing the shading  

 Placement of Image Paint is faster  
 

Plan Sets  

 Auto Crop to Nested Region option added when 
placing a Drawing that contains a Nested Region into a 
Plan Set  

 Centre on Plan Set includes Cropped Views  

 Close All added to right-click on Plan Set  

 Colour options added to PDF Export  

 Copy to SoftPlan Clipboard added to Plan Sets  

 Cropped Polygon Views can be created around static 
model images, Annotated views, and presentation 
views  

 Cropped Views include a buffer to account for line and 
pen thicknesses  

 Custom Building Option Visibilities added to embedded 
Annotated views on Plan Set pages  

 Landscape vs Portrait orientation option added to 
creation  

 Open All added to right-click on Plan Set  

 Plan Set Labels use the Overview Notes colour when 
Print Using Screen Colours is selected  

 Plan Set Templates added to Backup and Restore  

 Paste from SoftPlan Clipboard added to Plan Sets  

 Repeat Edit added for Items directly on a Plan Set  

 Repeat Edit added to default Floating Toolbar  

 Reset Position command added to drawing and view 
labels  

 Save as Template added to right-click on Plan Set  

 Zoom Extent ignores Drawing Labels if visibility option 
is off  

 Zoom World is removed from Plan Sets  
 
Print  

 Arc Length added to Print of radiused Site Lines  

 Colour options added: Pen Colour, Screen Colour, Pen 
Lines/Grayscale, Grayscale  

 Draw Select command works on Paint Breaks  

 Include Overlay column added to Batch Print menu  

 Overlay option added to Print  

 Plan Set Labels use the Overview Notes colour when 
Print Using Screen Colours is selected  

 Room Mode prints in shaded rather than solid black  

 
    
 
 
 
 
 
 
 

 
 

  
 
 

Posts  

 Adjust Height to Fit to Top of Beam option added  

 Adjust Height to Fit to... will look to the floor above to 
locate a beam  

 Braces added to Type Erase  

 Brace added to the items shaded when Show Polygon 
Shading is selected  

 Bracket option added to Brace  

 Deflection option added to Brace  
 

 

                
 
 Finds the Top or Bottom of Beam and adjusts the 

height of the Post. If there is no Beam, the Height will 
change to match the bottom of Ring Joist  

 Post Skirting option added — places a profile around 
the base of a post  

 Shaded option added to plan Posts  

 Stretching option added to Post definition  
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Railings  

 Post Skirting option added — places a profile around 
the base of a post  

              

                 
 

 Railings are automatically adjusted when a deck or 
stair edge is adjusted and Attach is turned on  

 Railing Overhang and Wall Returns display in plan 
view  

 Roof Vent override options added to Roof Edge Edit 
menu  

 Wrought Iron added to Railing Finish options  
 

 
reView  

 Overlay option added to PDF Export  
 

Roof  

 Accent Trusses added to stacked or nested Dutch 
Gables  
 

       
 

 Bird Box option added to Gable ends with raked Fascia  

 Clip to Ceiling option added to Gable End Roof Edge 
edit  

 Each Bird Box on a Gable Roof can have a different 
width  

 Default Sub-Fascia option added  

 Fascia option added to roof edge. Places a wood 
fascia onto the Sub-Fascia  

 Formation of Ridges and Valleys on angled roofs and 
angled portions of roofs improved  

 Frieze boards mitre when the Follow Bird Box option is 
turned on  

 Frieze under the lower roof of a Multi-Floor Roof 
properly mitres  

 Frieze forms properly on nested Dutch Gable style 
roofs  

 Frieze forms properly on nested Gable style roofs  

 Gable End material properly aligns with the wall 
material below when a Gable Vent is added  

 Gutters are properly added to roofs that have Hip 
Returns on opposite Gables of the same roof  

 Heel Height, Seat Cut, and Butt Cut are all editable on 
the roof poly level but only applied to the valid (hip) 
edges  

 If a roof has both Hip and Gable edges, the Roof Edit 
menu will list separate Hip Overhang and Gable 
Overhang values. If the roof does not have any Gable 
Edges, only an Overhang value will list  

 Remove Intersecting Material option added to Roof 
Edge Edit — removes the siding, brick, or stucco from 
the second floor that is buried behind a roof on the first 
floor  

 Repeat Edit acts on Crickets and Roofs on Bays  

 Ridge Cap placement improved  

 Ridge Vent option added  
 

       
 

 
 Rigid Frame command added — used for commercial 

and agricultural buildings  

 Roof on Bay command improved when used on a 
Multiple Floor Roof  

 Roof Faming sizes (Rafter Depth, Truss Chord sizes) 
are stored with the Roof, when a rafter or truss is 
added, it will use those sizes for the newly created 
framing member ignoring the drawing defaults allowing 
Seat Cut, Butt Cut and other values to be based on 
editable values so a house can have different rafter 
thicknesses on different roofs and the seat cut value is 
accurate  

 Shadow Boards extend properly on Dutch Gable end 
style roofs  
 

 

                          
 
 

 Slope Entire Roof command added to Edit menu when 
in Roof mode  

 Soffit placement on angled holes improved  

 When the Roof sits low on a wall (Top of Plate to 
bottom of Fascia is less than 125mm), the formation of 
the Hip Returns is improved  
 

 



SoftPlan 2024 Detailed Features  

13 

 

Roof Framing  

 If the first or last truss in a Truss Set is located near a 
Gable End, it will automatically be set to a Gable End 
Truss  

 Purlins improved on angled roof sections  

 Rafter Hanger option added to Roof Framing members  

 Sub-Fascia can be automatically added to a Truss Set  

 The maximum size (length) of an Accent Truss 
increased  

 Webbing is added to Jack Trusses with an energy heel  
 

 
Site

 Adjust Size command in Site mode allows Distance 
input  

 Arc Length added to Repeat Edit  

 Arc Length added to Display and Print of radiused Site 
Lines  

 Arc Radius added to Repeat Edit  

 Create Site Border command added under Tools menu  

 Default colour configuration added to Geo-location 
Point  

 If a Site Object is made visible in Drawing mode, it can 
be edited in Drawing mode  

 If the source shape for the Convert Shape to Site Line 
command is a polygon, the Site Line is created as a 
polygon  

 Form Polygon command does not change the shapes 
when combining a spline with a regular orthographic 
shape  

 

 

 Google Maps Satellite Image import added  

 Latitude and Longitude data for Geo-location Points 
can be entered in decimal degrees in addition to 
degrees/minutes/seconds  

 Layer option added to Geo-Location Point  

 Location Options added to the default Site mode 
toolbar  

 Modify Text option added to Edit of a Site Line  

 Pool command added  

 Project Options: North Options renamed to Location — 
includes Geo-location Point’s Latitude and Longitude  

 Site Plans no longer display Section Lines by default  

 Site Work can be drawn as a spline  

 When moving an image, the vectors are visible through 
the image making it easier to align items  

 
SoftList 
 Area Pricing option added allowing Cabinet Doors and 

Drawers to be priced by the square metre  

 beam_radius variable added to Group Beam  

 Constant ladder_stud added to list Ladder Studs 
separate from common studs.  

 Edges Length column added to Takeoff Schedules in 
SoftList drawing mode  

 Improvements made to combining very long Rafters on 
Cutlist Reports  

 glazing_area variable added to Group Openings  

 Variables has_ridge_cap, has_ridge_vent & 
ridge_vent_length added to Roof & Roof Plane 
components  

 Variable frieze_finish added  

 Variables fascia_finish, gutter_finish, soffit_finish, and 
shadow_board_finish added  

 Variables splash_board_finish, corner_board_finish, 
frieze_board_finish added to Group: Wall / Part: Wall  

 

 
Stairs  

 The Direction Arrow is continuous and the Total Riser 
Count is placed mid-landing  

 Default Landing Joist Depth option added to Stair 
Options  

 Default Stringer Depth set to 240mm  

 Left & Right options added to Nosing settings  

 Nosing settings added to Edit of Landing Edge  

 Right-click menu in 3D and Ceiling Mode includes Stair 
Headroom Clearance Hole command  

 Show On Floor Above and Show On Floor Below 
commands added to the right-click of a Stair  

 Stringer Width option added — allows for the creation 
of Mono or Floating Stairs  

 Thickness option added to Treads  
 

 
Symbols  

 Symbols with Attributes have a "label" and a "default 
value"  

 Stretching options added to Symbols  
 

 
Wall Framing  

 Custom Header Plate option added, allows a Plate to 
be placed directly Above or Below the Header  

 Hurricane / Cyclone Straps added  

 Garage Buck height calculations improved.  

 Parapet Walls included in Wall Panel drawings  

 Square Stud added to Form Corner Style, places a 
solid Stud at the corner  

 Structural Grid command added  

 Wall Plates are staggered in the 3D view to match the 
Wall Panel diagrams  

 Exclude From Unit option added to Opening Header  
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Walls  

 Default Layer option added to Wall Definition menu  

 Inset Frieze shortens the Wall Material by the Frieze 
Height  

 Frieze forms properly at the corner of 2 different wall 
types  

 Frieze improved when under one roof section but over 
another  

 Frieze application to False Gable with Bird Boxes 
improved  

 Frieze eliminated when a roof intersects a wall under a 
roof above  

------------------------------------------------------------------- 
 
 

 
Additional content has been added specifically to 
SoftPlan 2024 as supplied to Australia and New 
Zealand by Cadbuild. 
 
 
Please see:   
Locally added items to SoftPlan2024 
Available on www.cadbuild.com.au 
 

Walls 

 Glass shower wall added 

 Block wall with gyproc lining, 22mm battens and 
footing 

 
Beams 

 Deck beams – 18 LVL Pressure Treated 

 Beam - 18 LVL Pressure Treated 
 

Openings 

 12 Pivot Entrance style doors 

 10 Pivot Shower doors 

 5 Thin framed glass doors added to Colonial library 

 5 Glass External Bifold doors 

 3 Glass Internal Bifold doors 

 4 2400mm high roller doors 
 
Door Hardware 

 4 Vertical door handles 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 Footing Projection override option added to Footing 
Edit  

 Inset Corner Board option added to Wall Definitions  

 Projection Snap includes non-visible wall materials  

 Reverse Board & Batten siding profile added  

 Search command added to the Draw > Wall menu  

 Slope Step option added to Style setting on Wall 
bottoms —the bottom of the footing is sloped while the 
top steps  

 Stud-LVL-Insulated material type added  
 
 
-------------------------------------------------------------------------- 
 
 
Symbols 

 4 Mixer Taps - Bathroom library 

 4 Above vanity sinks – Bathroom library 

 4 Garden Taps – Landscape library 

 EV Charging Panel – Mechanical library 

 EV Charging Signs – Signs library 

 Solar Storage Battery – Mechanical library 

 Fire Extinguisher – Mechanical library 

 Fire Blanket sign - Signs library 

 Fire Blanket 3D symbol – Mechanical library 

 Fire Blanket 2D symbol – Signs library 

 350 x 350 Hollow column – Exterior library 

 Hollow column – Shapes library 

 2 Post Stirrups – Set in or bolted down style – 
Mechanical library 

 
 

 
 
 
Post 

 90mm Post with offset for stirrups  

 90mm Post with zero offset 
 
Banding 

 Brick sill profile added to banding 
 

 
 

Additional Local Content 
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Profiles 

 Hardies Axon®, Oblique®, and Stira® added to 
Profiles > Cladding library 

 
Textures  

 Updated ColorBond textures for corrugate roofing 

 Updated ColorBond textures for fencing 

 Added Concrete stencils – Exterior finish library 

 4 Wagners CFT  Decking textures – Manufactures 
library 

 

 
 
 
 
Keyboard Shortcuts  

 Ctrl + O = Overlay 

 Shift + V = Visible Items 

 V = Block Move 

 Alt + A = Align to Edge 

 3D Shortcuts – O = Sun Options 

 3D Shortcuts – L = Lighting Options 
 
 
 
 
 
 
 

 

Finishing Options 

 To go with the new 2024 finishing options, textures 
have been set for: 
Fascia, Gutter, Soffit, Shadow Board and Transition 
Board – selected in roof options 
 

 Textures have been set for Corner board, Frieze Board 
and Splash Board – selected in Material Dimensions > 
Trim Options 

 
Line 

 3 dashed lines added to line styles 

 Updated centre line character 
 
Plan Set 

 Cover Sheet title block updated with @property_area 
 
SoftList 

 Following items has been added or updated to the 
Summary, Detailed short and full format reports  

 Decking beams – LVL Pressure Treated 

 Deck Ledger Boards - Timber and Steel 

 Decking Ring Joists - Timber and Steel 

 Ceiling Ring Joists - Timber and Steel 

 Top Hat 64 Wall members 

 Grill - Floor 

 Grill - Wall 

 Grill - Ceiling 
 Floor Joists – Timber and Steel 

 Brace – Bracket 

 Post Shirts – Round or Square 

 Accent Truss 

 Cyclone (Hurricane) Straps 

 LVL Studs added to Stud formula 

 Pool values, for excavation, area and coping 

 Updated Site coverage and Site details to include pool 
values 

 
 
 
 

SoftPlan+ cloud drive and services 
 
SoftPlan+ is a suite of tools that enrich the design process by providing users with the very best 
SoftPlan experience available. 
Includes: 

 Online Training Content 

 reView - 2D & 3D designs on iPad, iPhone & Android      

 PDF – Import and Export PDF files 

 reView – import and export SoftPlan reView files 

 panorama 3D for PC, iPad, iPhone or Android  

 360° photo interactive images that can be panned & explored 

 Google - import 3D terrain and satellite images directly from Google 

 Sketchup – import / export expands modelling options at your disposal 

 Premium manufacture content with high quality 2D/ 3D symbols  
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SoftPlan+ web3d model viewer 
 
Exclusive to SoftPlan subscribers and SoftPlan+ subscribers, this 

feature allows you to publish 3D models directly to the web to be 

viewed by anyone you wish.  

Once published, SoftPlan creates a link to your web3d page 

which we host on our site. Anyone you share this link with can 

view and explore your project without needing to download and 

install any additional software. 

  

SoftPlan web3d models can be viewed and navigated on PC, 

phone, or tablet. 

 
 
 
 
 
 

    
 
 
 
 

SoftPlan+ Upgrade Pricing 
This is to upgrade already owned copies of SoftPlan. 
 
SoftPlan+ subscription: 
 

$125/month 
 
SoftPlan+ is a subscription service. 
 
SoftPlan+ is the only method to upgrade an existing SoftPlan to a newer version. 
 
SoftPlan+ subscriptions are applied to copies of SoftPlan already owned and are not additional 
copies.   
 
Subscriptions only available in Australia and New Zealand and must be paid by credit card. 
 

 
 
 
 
 

Scan the QR code to take a tour of 

this historic renovation using 

SoftPlan’s web3d technology on your 

computer, tablet, or phone. 
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